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General Application Information

Application Layout

PowerAgent 7 consists of 4 components: Toolbars, User Window, Activities Window and
the Tabbed Activity Detail Window. There are two toolbars located at the top of the
application — the Menu Toolbar and the Icon Toolbar.

Located just beneath the toolbars on the left-hand side of the application is the User
Window. This window displays all users that are being managed through the application.
Below the User Window on the left-hand side of the application is the Activity Window. The
Activity Window displays all activities for the user that is selected in the User Window.

The Tabbed Activity Detail Window takes up the most real estate in PowerAgent and is
located beneath the toolbars on the right hand side of the application. This window is used

to display all the details of a selected activity. Multiple activities can be open at a time and
the user can toggle between the tabs.

Menu Items

The main toolbar consists of 5 menus: File, Edit, Tools, Window and Help. The file menu
provides the user with the ability to:

= Add User
= Exit
The Edit menu provides the user with the ability to:
*  View Activity(s)
= Delete Activity(s)
= Edit User
= Delete User
= Application Settings
The Tools menu provides the user with the ability to:
=  Download Activity Data
= Configure Device
»= Import Activity Data

= Export Activity Data
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= Update Device Firmware
The Window menu provides the user with the ability to:
= Show Users Window
= Show Activities Window
= Close Window
= Maximize Window
The Help menu provides helpful information to the user such as:
= Contents

= About (PowerAgent 7)
Icons

There are numerous icons that are used throughout the application. Please review the
icons below along with their descriptions.

qr
ey Add User — Provides the ability to add a user.

3
™

Edit User — Provides the ability to edit a user.

Remove User — Provides the ability to delete a user.

View Activity — Provides the ability to view an activity.

Delete Activity — Provides the ability to delete an activity.

Download Activity Data — Provides the ability to download activity data.

Configure Device — Provides the ability to configure the CPU or Console.

Import Activity Data — Provides the ability to import data.

Export Activity Data — Provides the ability to export data.

Application Settings — Provides the ability to modify application settings.

E rFE R el X E G

Update Firmware — Provides the ability to update device firmware.

L
i

Merge — Provides the ability to merge activity files together.
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E Save — Provides the ability to save activity files.
o Refresh — Provides the ability to refresh the download window.
@I Help — Provides the ability to view Help documentation.

Application Settings

PowerAgent 7 allows the user to control some settings within the application. The user can
control the following:

= Measurement Units - The user can select English or Metric.
= Date Format — There are a variety of different date formats the user can choose.

= Time Format — The user can choose from either a 12-hour or 24-hour time
format.

= Language — The user can choose from 5 languages — English, French, Spanish,
[talian and German.

= Communication Port — The user can choose which communication port
(ComPort) their device will always be plugged into or they can select Auto-detect
and the application will determine the port automatically.

To modify Application Settings, click on the Edit menu and choose the ‘Application
Settings’ menu option.

User Window

The User Window displays the users that are stored within PowerAgent. It can store an
unlimited number of users. To edit a user, simply highlight and double-click on the
selected user.

The User Window has two buttons on it — Minimize and Close. To minimize the window,
click on the Minimize button. While the window is minimized, a button for the window is on
the left hand side of the screen. Mouse over the button and the panel appears. To restore
the window, click on the Restore button. To close the window, click on the Close button.

Activities Window

The Activities Window displays all the activities for a given user. For each activity the date,
distance, duration and Total Work (kjs) are displayed. The Activities Window is sorted by
activity date from the most recent to the oldest. The order of the columns can be
changed as well. To do this, click on the column heading and drag the column to the
desired location. Above the vertical scroll bar there is a button where the users can
showr/hide the columns and can turn on the horizontal scroll.

To view an activity, highlight and double click on the activity. If you want to view multiple
activities, highlight all the activities and click on the ‘View Activity’ @l icon on the icon
toolbar. To delete an activity, click on the ‘Delete Activity’ # 1con displayed on the icon
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toolbar. If you want to delete multiple activities, highlight all the activities you wish to delete
and click on the ‘Delete Activity’ # 1con on the icon toolbar.

The Activities Window has two buttons on it — Minimize and Close. To minimize the
window, click on the Minimize button. While the window is minimized, a button for the
window is on the left hand side of the screen. Mouse over the button and the window
appears. To restore the window, click on the Restore button. To close the window click on
the Close button.

Tabbed Activity Detail

When an activity is opened, a ‘tab’ is created in the main window of the application. This
tab contains detailed information about the activity such as summary data and a variety of
graphs. Multiple activities can be opened at one time for multiple users. Each activity tab is
identified with the User's name and the date of the activity. To close an activity, click on the
‘X’ on the tab.

Customizable Layout

Power Agent 7 provides the user with the ability to customize the layout of the application.
The user has the freedom to move around the User, Activities and Tabbed Activity Detall
windows.

To move a window, click on the window and while continuing to click on the window, drag
it to it's desired location. See below for several examples of how the docking of windows
can change the look and feel of PowerAgent 7.
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This view shows the User and Activities Window stacked on top of each other with the
Tabbed Activity Detail windows displaying in the main area of the application.
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This view shows the User and Activity Windows on top of each other. You can tab
between these two windows when laying out the windows in this way.
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This view shows the User Window minimized on the far left toolbar. The Activities Window
is docked on the left hand side of the application. The Tabbed Activity Detail windows are
stacked on top of each other to allow for a comparison between activities.
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Configuring the Device

To begin the process of configuring your PowerTap CPU or Indoor Cycle console, you first
need to connect the device to the computer and turn the device on. Once the device is
connected and on, click on the ‘Configure Device’ icon. A window opens prompting the
user to select the connected device. Use the drop-down menu to select the device and
click ‘OK’.

The Configure Device window appears and the user is able to configure each device.
Each device has some slight variations in settings. These variations will be addressed
below. To save the settings, click on the ‘OK’ button when finished. Otherwise, click
‘Cancel’ to discard any changes.

The PowerTap wired CPU contains the following configuration settings:
= Bike Set-Up: Measurement Units, Wheel Circumference and Odometer
= Display Set-Up: Time Format, Middle Display, Power Averaging, Speed
Averaging, Cadence Averaging, and Heart Rate Averaging with the ability to

include or not include zeros in Power, Speed and Cadence

= CPU Set-Up: CPU mode, Cadence Source, Record Control, Record Rate, Sleep
Timer and Automatically Adjust Torque Offset

The PowerTap wireless CPU contains the following configuration settings:
= Bike Set-Up: Measurement Units, Wheel Circumference and Odometer
= Display Set-Up: Time Format, Middle Display, Power Averaging, Speed
Averaging, and Cadence Averaging with the ability to include or not include zeros

in Power, Speed and Cadence

= CPU Set-Up: CPU mode, Cadence Source, Record Control, Record Rate, Sleep
Timer and Automatically Adjust Torque Offset

=  Wireless Set-Up: Hub ID, Cadence Sensor ID, Heart Rate ID and Speed Sensor
ID

The Indoor Cycle Console contains configuration settings for the Console and for each of
the 6 Users.

= Console: CPU Mode, Time Format, Record Control, Language, Ride Type and
Sleep Timer

= Users (Up to 6):
0 User Information: Name, Weight, Date of Birth and Gender

0 Training Zones: Power and Heart Rate Zones
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0 Settings: Measurement Units, Odometer, Record Rate, Heart Rate
Sampling, Include Zeroes and Play Audible Alerts

If you have any questions specifically about these settings, please review the Owner's
Manual that came with your device. If you can not find or have misplaced this manual, visit
www.cycleops.com and download the owner’'s manual for the device.

Managing Users

Adding a New User

To add a new user, click on the ‘Add User’ -:-_3 icon in the top right hand corner of the User
Window. The Add User wizard appears.

On the first screen of the Add User wizard, enter user information. Enter in the full name,
the display name and the weight of the User. Comments about the user can also be
entered and stored with the user’s profile. Click ‘Next’ to continue or Click ‘Cancel’ to close
the window without saving the user details.

On the second screen of the Add User wizard, enter in the power zone information. There
are two ways of doing this. Either enter the Peak Power for 4 minutes and 30 minutes and
click ‘Generate’ or in the Zone Values section, move the sliders for each zone until the
zone ranges are set. For more information on how to obtain your Peak Power for 4
minutes and 30 minutes, visit www.cycleops.com. Click ‘Next’ to continue or Click ‘Cancel’
to close the window without saving the user details

On the third screen of the Add User wizard, enter in the heart rate zone information.
There are two ways of doing this. Either enter the user's maximum heart rate and click
‘Generate’ or in the Zone Values section, move the sliders for each zone until the zone
ranges are set. Click ‘Finish’ to save the user details, click ‘Back’ to go back and make
changes to the user information or click ‘Cancel’ to close the window without saving the
user details.

Deleting a User

To delete a user, highlight the user you would like to delete and click on the ‘Delete User’
<2 icon in main Icon Toolbar. A confirmation message will appear alerting you that you
are about to delete a user and all their activities. Click “Yes’ to delete the user and all their
associated activities. Click ‘No’ to discontinue the deletion of the user.

Editing a User

To modify a user’s profile data, highlight the user you would like to modify and click on the

‘Edit User’ < icon in the User Window. The Edit User window opens and the user’s data
can be modified.

The Edit User window is made up of 4 tabs. The first tab contains general user information
including Name, Display Name, Weight and Comments. The second tab contains Power
Zone settings. The user's power zones can be updated from this tab. The third tab
contains Heart Rate Zone settings. The user's heart rate zones can be updated here.
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The final tab contains the Peak Power Records for the user. This tab displays the duration
of each peak power interval. The durations are 5 seconds, 30 seconds, 1 minute, 5
minutes, 10 minutes, 30 minutes, 60 minutes and 120 minutes. For each interval, the
user's best peak power is displayed as well as the date on which that interval occurred. If
any of the values are incorrect for any reason, the user can check the ‘Manually Edit
Values’ checkbox and adjust the peak power values. Click the ‘OK’ button to save the
changes made or ‘Cancel’ to ignore the changes.

Downloading Activity Data

To begin the process of downloading activity data from your PowerTap CPU or Indoor
Cycle console, you first need to connect the device to the computer. Once the device is
connected, select the user you wish to download activity data for and click the ‘Download

Activity Data’ icon.

A window appears and the port your device is plugged into is automatically recognized by
the application. Click the ‘Download’ button to begin downloading activity data. If you

experience a problem with your device being recognized, click the ‘Refresh’ @ icon.
During the download process a status bar will move back and forth indicating that data is
being downloaded into PowerAgent 7.

Once the download is complete, a window will open displaying all activities that were
downloaded from the connected device. The window displays the name of the file, the
distance of the activity, the duration of the activity and the total kilojoules for each activity.
In this window, you have the option of deleting activities, merging activities, changing the
date/time of the activity and/or adding comments regarding a particular activity. The next
few sections describe each of these processes.

Modifying Activities

There are several details of an activity that can be modified. The application provides the
ability to modify the date/time of the activity. It also enables users to add comments to an
activity. Only one activity can be modified at a time. The application does not provide the
ability to select multiple activities and modify the date/time or add comments.

To modify the details of an activity, highlight the activity in the download window and enter

the updated time/date and comments. Click on the ‘Save’ E] icon in the upper left corner
of the download window. The modified activity is saved and removed from the data grid in
the download window.

Deleting Activities

To delete an activity, highlight the activity or activities that should be deleted. Click on the

‘Delete Activity’ icon in the upper left corner of the download window. The selected
activities are deleted and removed from the data grid in the download window.

Merging Activities

To merge several activities together, highlight the activity or activities that should be
merged. Click on the ‘Merge’ #& iconin the upper left corner of the download window. The
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selected activities are merged and one activity is displayed in the data grid in the

download window. Click on the ‘Save’ E] icon in the upper left corner of the download
window. The newly merged activity is saved and removed from the data grid in the
download window.

Saving Activities

To save a single activity, highlight the activity you wish to save. Click on the ‘Save’ E]
icon. The activity is saved and removed from the data grid in the download window. If you
are done saving activities, click the ‘Close’ button.

To save multiple activities, highlight each activity you wish to save. Click on the ‘Save’ E]
icon. The activities are saved and removed from the data grid in the download window. If
you are done saving activities, click the ‘Close’ button.

Managing Activity Data

Selecting/Viewing Activities

To view the details of a particular activity or activities, highlight the activity or activities from
the Activity Window. Next, click on the ‘View Activity’ Bl icon. A tab will open up for each
activity selected in the main window. Each tab is labeled with the name of the User as well
as the date of the activity. Multiple tabs for multiple users can all be opened at the same
time.

Deleting an Activity

To delete an activity or activities from the main application window, simply highlight the
activity or activities you would like to delete from the Activity Window. Click the ‘Delete
Activity’ ® icon. A confirmation message will appear alerting you that you are about to
delete an activity or activities. Click ‘Yes’ to delete the activity or activities. Click ‘No’ to
cancel deleting the activity or activities.

Activity Summary

The activity summary view consists of 4 sections of data. The first section is a summary of
the activity. This section includes the following:

= Date/Time of the Activity

= Distance
= Duration
= Work

= Max/Average Power

= Max/Average Cadence
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= Max/Average Speed
= Max/Average Heart Rate
= Max/Average Torque

=  Peak Power for 5 seconds, 30 seconds, 1 minute, 5 minutes, 10 minutes, 30
minutes, 60 minutes, 120 minutes

=  Comments

The second section consists of a graph that compares the user’s peak power numbers for
the activity against their best peak power numbers from across all their activities. The
yellow line represents the peak power for the selected activity and the blue line represents
the best peak power across all activities. Time is on the X-axis and Power is on the Y-
axis.

The third section consists of a graph that displays the amount of time the user spent in
each power zone for the selected activity. The Power Zones are displayed across the X-
axis. Time is displayed on the Y-axis.

The fourth section consists of a graph that displays the amount of time the user spent in
each heart rate zone for the selected activity. The Heart Rate Zones are displayed across
the X-axis. Time is displayed on the Y-axis.

To print any of the three graphs, right-click on the graph and click ‘Print’. You can also click
‘Save As’, save the graph and then print it later.

Activity Detail

The activity detail view allows the user to drill down and look at the activity in more detail.
The user is able to:
= View the Full Activity
View each Interval
Create and Save Intervals
Zoom in sections of the activity and view the selected section
View a summary of the data for the full activity and each interval.

A graph of the activity is displayed that graphs Power, Speed, Heart Rate, Cadence and
Torque on one graph. The X-axis displays the duration of the activity and Y-axis graphs
the values for power, speed, heart rate, cadence and torque. Power is represented by a
yellow line. Speed is represented by a blue line. Heart Rate is represented by a red line.
Cadence is represented by a green line and Torque by a purple line.

The summary data below the graph includes Date/Time, Duration, Max/Average Speed,
Max/Average Cadence, Max/Average Power, Max/Average Heart Rate and Max/Average
Torque. By default it displays summary data for the entire activity.

See below for an example:
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Full Rid
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To view intervals, select the interval you wish to view from the drop-down box above the activity
graph. When an interval is selected, the summary data is updated to reflect the selected interval.

See below for an example:
Interval 2

Yalue

25 40 45 &0 55 G0 G5 70 75
Elapszed Time

— Hearn Rate — Speed — Cadence Power —anque|

To zoom in on a section of the graph, simply click with your mouse and highlight the entire area
you wish to view. The summary for the zoomed-in section adjusts to display only the values for
the selected section of the activity.
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Once you have zoomed in on a section of the activity, you can create and save intervals. To save
the zoomed in section of the ride as an interval, click the ‘Save Interval’ button in the bottom left-
hand corner of the Activity Detail Tab. A window pops-up where the user must name the interval
that is about to be saved. Enter in a name and click ‘OK’. The interval is saved and can be
selected from the Saved Intervals drop-down box.

To turn the zoom feature off, select the ‘Entire Activity’ from the Intervals dropdown. The graph will
return to the full activity.

See below for an example:
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Importing Activity Data

PowerAgent 7 allows the user to import activity files from previous versions of
PowerAgent, PowerLink Lite and PowerLink.

To import an activity, highlight the user for which you would like to import activities. Click

on the ‘Import Activity Data’ icon, which is located on the icon toolbar just below the
menu toolbar. A window opens up, which allows you to find the file or files you would like
to import on your computer. Select the file or files you would like to import and click the
‘Open’ button.

A new window opens that displays all the activities you wish to import. The window
displays the date/time of the activity, the distance of the activity, the duration of the activity
and the total kilojoules for each activity. In this window, you have the option of changing
the date/time of the activity and/or adding comments regarding a particular activity.

To save a single activity and update the date/time, highlight the activity you wish to import
and update. Enter in the new date/time and/or comments. Next click on the ‘Save’ button.
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The activity is saved and removed from the data grid in the Import Window. If you are
done importing files, click the ‘Close’ button.

To save multiple activities, highlight each activity you wish to import. Next click on the
‘Save’ button. The activities are saved and removed from the data grid in the Import
Window. If you are done importing files, click the ‘Close’ button. If you choose to save
multiple activities simultaneously, you will not be able to modify the date/time or add
comments about a particular activity.

To merge several activities together, highlight the activities you wish to merge. Click on the

‘Merge’ € icon. The activities are merged together and now form one activity. Highlight

the newly merged activity and click the ‘Save’ button to save the activity data.

To delete an activity from the Import Window, simply highlight the activity or activities you

wish to delete and click on the ‘Delete’ #% icon. The activity is removed from the data grid
in the Import Window. In addition, if there is an activity or activities that you no longer wish
to import, you can simply click the ‘Close’ button when you are finished and the activity(s)
will not be imported.

Once you have completed importing an activity, you can view the activity and its details by
highlighting and double clicking on the activity in the Activity.

Exporting Activity Data

To export activity data, select the user and the activity that you would like to export. Click

on the ‘Export Activity Data’ . icon. A window opens which allows you to name the file
and choose a location to save it to. When you export an activity, a CSV file is created. This
file can be opened in an application such as Microsoft Excel. It provides the user with all
the data from the activity.

Updating Device Firmware

Throughout the lifecycle of the PowerTap CPU and the Indoor Cycle console, there will
need to be changes made to the software that is located on the hardware. This is called
firmware. PowerAgent 7 provides a convenient way for users to update the firmware on
their device.

First, navigate to www.cycleops.com and follow the links to the Download page. Click on
the ‘Firmware’ button. Download the latest firmware version for your device to your PC.

Second, connect the device that needs to be updated to your PC. Once the device is
connected, select the ‘Tools’ menu option and click on the ‘Update Device Firmware’
menu option. A file explorer window opens. Navigate to the location where the
downloaded firmware file was stored. Select the file and click on the ‘Open’ button.

Next, a window opens and requires you to select the port that your device is connected to.
After selecting the port, click on the ‘OK’ button. A confirmation dialog box will appear
asking if you are sure you want to update the device that is attached to the selected port.
Click “Yes'. A window appears which displays the status of the update.
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When the device has finished updating, a dialog box will appear stating that the update is
complete. Click ‘OK'. It is now safe to disconnect the device.

The Help menu contains two options. The first option is Contents which directs the user to
view this document. The second option is About. This option gives the user specific
information about the version of Power Agent they are using.

There are two tabs in the About window — About and Detail. The ‘About’ tab displays the
flash image of the version of PowerAgent that is running.

® About

 About!| Detai|

PowerAgent 7.0

CyecleOps @
POWER

The other tab in the About window is the ‘Detail Tab'. This tab provides the user with the
following information about PowerAgent. Product Version, Operating System, Java
Version, Virtual Machine, Vendor, Java Home, System Locales, Home Directory, Current
Directory, User Directory and Install Directory.

@ About

About ' D

@ PowerAgent 7

Product Yersion: Powerfigent 7

Dperating System:  Windows %P version 5.1 running on %86

Java: 1.5.0_06

¥M: Java HotSpob{TM) Client ¥M 1.5.0_08-b0s

¥Yendor: Sun Microsystems Inc,

Java Home: C:\Program Files)Javaljrel.5.0_06

System Locale: en_US (poweragent)

Home Dir: C\Documents and Settingsiaparadawski

Current Dir: C:\Program Files\PowerAgent 7ipoweragentibin

User Dir: C:\Documents and SettingslaparadowskitApplication Datal. poweragentidey

Ci\Program Files\PowerAgent #ipoweragentiplatforms

Install Dirs: C:\Program Files\Powerfgent ?\poweragentipoweragent
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